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Beginner's Guide to Adobe
®
 Photoshop

®
 

Elements 5.0 
BEFORE YOU BEGIN 

This guide has been written primarily to assist users wanting to edit and enhance 

their photos using the digital photo editing application Adobe Photoshop 

Elements 5.0.  At the time of writing this application is currently only available on 

the public cluster PCs with scanners on level 0 of the J B Priestley Library. 

If you have Adobe Photoshop Elements 5.0 installed on your own PC, you will be 

able to take full advantage of its extensive sharing and searching capabilities, 

which enable you to tag and organise all your photos into a catalogue.  However, 

these features are not available on public cluster PCs and are not covered in this 

document. 

ABOUT THIS GUIDE 

This document assumes no previous knowledge of any graphical application and 

aims to introduce you to the Adobe Photoshop Elements interface and to show 

you how to use some of its tools. 

As with most image editing and processing applications, Adobe Photoshop 

Elements has far too many features to be addressed in one document.  After 

working through this guide, it is recommended that you refer to the extensive 

information available from the Help menu, for more specific assistance.  

STARTING ADOBE PHOTOSHOP 

1. To access Adobe Photoshop Elements, click on the Start button and then 

select in turn:  All Programs, Scan & OCR Utilities, Adobe Photoshop 

Elements 5.0. 

The Welcome screen offers 

the following options: 

View and Organise Photos 

– opens the Organiser 

workspace into which you 

can import, tag and organise 

your photos.  (For those with 

Photoshop Elements 

installed on their own PC) 

Quickly Fix Photos - opens 

the Quick Fix workspace of 

the Editor.  Contains many 

basic tools for photo 

correction and is ideal if you 

have no experience in digital 

imaging. 
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Edit and Enhance Photos – opens the Full Edit window which contains a 

complete range of advanced image correction tools for light and colour, selection, 

text and image defection.  

Make Photo Creations – for showing off your photos in unique ways, eg creating 

greetings cards and slide shows. 

2. Click on the Quickly Fix Photos icon to learn the basics of image editing. 

EDITING A PHOTO IN THE QUICK FIX WORKSPACE 

1. Observe the Tools and Palettes area in the Quick Fix workspace. 

 

 
 

The palettes area on the right-hand side contains controls to change colour, 

lighting or enhance detail in a photo.  These can be applied automatically by 

clicking on the Auto buttons, or in stages by dragging the sliders (which become 

visible when a photo is opened). 

The toolbox on left-hand side comprises the following five tools – Zoom, Hand, 

Magic Selection Brush, Crop, and Red Eye Removal.  Whenever one is selected, 

further options applicable to it are displayed in the Options bar. 
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The shortcuts bar contains buttons for moving between common commands, eg 

printing, or moving to the Full Edit workspace. 

2. To open your photo, click on File, Open and navigate to the correct location.  

Select the file then click on Open. 

3. Ensure Before and After is displayed in the View: box.  Two copies of the 

image will then be displayed enabling you to compare any changes you make 

with the original. 

4. If necessary click the Zoom arrow and either drag the slider, or type in a new 

value to adjust the magnification. 

Saving the File 

Before you start editing an image it is important to make a copy of the file and 

always work on that, as keeping the original intact means you can always revert 

to it should the unforeseen happen. 

You should initially save your image as a Photoshop file (.PSD) as this preserves 

all the image data and doesn't compress the file.  (If you frequently save a file in a 

format which compresses the data, eg JPEG, after time the image quality will be 

reduced.)  When editing is complete, you can then save the file in the desired 

format, eg JPEG or GIF.  

1. Click on the file menu and 

choose Save As. 

2. In the format: box, click the 

down arrow and select 

Photoshop (*PSD;*PDD) 

3. In the Save Options section, 

ensure the boxes for "Include in the Organizer" and "Save in Version Set with 

Original" are unselected. 

4. Click on Save. 

Correcting Colour 

The General Fixes section on the right-hand side of the window contains the 

following photo fixing tools.  These can be used on the whole image, or an area 

which you have specifically selected, eg with the Magic Selection Brush Tool.  

Smart Fix - use the Auto button to automatically correct colour, and improve 

shadows and highlighted areas.  If necessary drag the slider to vary the 

amount of adjustment. 

Red Eye Fix - will automatically find and correct red eyes.  

Levels – adjusts the overall contrast and may affect colours.  Good for 

images which need more contrast and have a colour cast to them. 

Contrast – use to adjust contrast without affecting the colour. 

Lighten Shadows – will lighten darker areas, leaving highlights unaffected. 
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Darken Highlights – darkens lightest areas without affecting shadows. 

Midtone Contrast – adjusts the contrast middle tonal values leaving extreme 

highlights and shadows untouched. 

Color – use to improve colour and contrast. 

Saturation – makes colours more vivid or muted. 

Hue – changes all colours in an image. 

Temperature – adds red or blue to warm up or cool down images. 

Tint – makes colour more green or magenta.  Use in conjunction with the 

temperature setting. 

Sharpen – enhances the detail in an image. 

Note: It is advisable to apply changes one at a time, review them and if the result 

is unsatisfactory, click the Reset button and try another.  In most cases 

you will not need to use more than one Auto command per image.  The 

Sharpen feature should always be the last command used. 

1. To keep track of the original image, ensure the Before and After option is 

selected in the View: box. 

2. Select one of the Auto buttons and observe the effect on the After: image. 

3. If necessary drag the slider(s) to make further changes.  The slider(s) can 

also be used independently of the Auto Buttons. 

Zoom Tool 

Use the Zoom tool to magnify an area. 

1. In the Toolbox click on the Zoom Tool    button. 

2. In the Options Bar, click the Zoom In    or Zoom Out    button, then 

click the area you want to magnify.  Each click magnifies the image to the next 

preset percentage. 

To magnify a specific area, ensure the Zoom In tool is selected, and then 

drag the tool over a particular area. 

Hand Tool 

The Hand tool works like the scroll bars, and lets you view areas outside the 

current window. 

1. In the toolbox, click on the Hand tool.  . 

2. Hold down the left-mouse button on the image and drag to move it around in 

the preview window. 

Magic Selection Brush Tool 

If you want to change a particular area in a photo you can easily do this using the 

Magic Selection Brush.  By selecting the specific area on which you want to work, 
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you can then apply special effects to it, or copy it for use elsewhere, without 

affecting the rest of the image.  

The Magic Selection Brush Tool allows you to click or roughly draw over the area 

you want to select, and then, using the colours and textures beneath your 

strokes, select other areas with the same. 

1. In the Toolbox, click the Magic Selection Brush tool  .  (If an Adobe 

Photoshop Elements message box appears, click on OK.) 

2. Note the buttons in the Options bar. 

 

 

 

3. Depending on the area to be selected you may wish to use a larger or smaller 

brush.  To do this, click the Size: arrow and drag the slider.  The selection 

colour of the brush can also be changed if by choosing a new colour from the 

Color menu. 

4. Ensure the New selection button is selected, then in the "After" photo, click or 

roughly draw over the area of the image you want to select. 

 

Magic Selection 
Brush tool 

Indicate 
Foreground 

New 
Selection 

Indicate 
Background 

Selection 
Brush tool 

Brush 
size 
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5. After a few seconds Photoshop will 

generate a selection based on the 

colours and textures in the area you 

covered.   

When an area is selected, it contains a 

marquee - a moving border of black 

and white dashes. 

If the selected area is unsatisfactory, 

cancel the selection (press the 

CTRL+D keys together), then select a 

different brush size and try again.  

 

Adding to or Removing from a Selection 

1. If the current selection doesn't include as much information as desired, select 

the Indicate Foreground button    and click or drag over the new area to 

be included. 

2. To remove unwanted content, use the Indicate Background    brush.   

3. Having defined the selection, you can now use the controls on the right-hand 

side of the window to change the selected content by clicking the relevant 

Auto button, or dragging the slider. 

Cropping 

Use the Crop tool to select an area and then cut off unwanted areas. 

1. In the Toolbox, click on the Crop tool    and note the choices in the 

Options bar. 

By default No Restriction is selected, allowing the image to be resized as you 

wish.  If you choose this method, the resolution of the cropped image will 

remain the same as the original. 

Note:  to view the resolution of an image, click on the Image, Resize, Image 

Size.  The current resolution is listed in the Document Size: section.  

2. To crop to a specific size, click the Aspect Ratio: arrow on the Options bar 

and choose: 

Use Photo Ratio – to keep the aspect ration of the image when cropped, or 

A Preset size - the resolution will change to fit the preset. 

Alternatively, enter specify values in the Width and Height boxes. 
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3. Drag the Crop tool over the area you want to keep, and release the mouse 

button.  A marquee will surround the selected area. 

 

4. If the selection is satisfactory, click on the Commit button    at the edge of 

the marquee to accept or click the Cancel button    to reject. 

Red Eye Removal 

Use this tool to correct red eye in a photo. 

1. In the toolbox, click the Red Eye Removal Tool   button. 

2. Move the pointer over the affected eye and click once.   

3. If the result is unsatisfactory, click on the Reset button, and then make 

adjustments in the Pupil Size and/or Darken Amount boxes in the Options 

bar before clicking the red eye again. 

EDITING A PHOTO IN THE FULL EDIT WORKSPACE 

The Full Edit workspace contains more advanced tools to correct image defects, 

create special effects and enhance photos.   

To access the Full Edit workspace 

from the Quick Fix screen, click the 

Full Edit button in the top-left 

corner. 

(You can also access Full Edit 

directly from the Welcome Screen, 
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by clicking on the Edit and Enhance photos icon.) 

 

The Full Edit window's toolbox is situated down the left-hand side.   When a tool 

is selected, an Options bar is displayed above the workspace enabling you to 

make further choices.   

The Photo Bin at the bottom of the workspace will display all open images. 

On the right-hand side is the Palette bin; palettes help you to manage and modify 

your images and can be expanded or collapsed as necessary.   

The How To Palette 

The How-to palette provides assistance for a variety of image-editing tasks.  (If it 

does not appear in the Palette Bin, click on Window, How To, and drag it into a 

suitable position).  Click a topic you are interested in to get relevant information. 

Where applicable it will offer a Do this for me link, which you can click on and 

have Photoshop Elements carry out the task for you.  To return to the How To 

topics at any time, click the Home    button in the palette. 

Full Edit Toolbox 

The Full Edit toolbox on the left-hand side of the 

workspace contains a wide range of tools.  

1. Position the pointer over a tool to see a 

description of it.  Most tools contain a link 

which will take you to the relevant help topic. 
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2. For tools which contain a small triangle in the lower right corner, click and hold 

down the mouse on a tool to display further hidden tools. 

Skin Tone Adjustment 

This feature enables you to click an area of a person's skin and automatically 

improve the tonal balance of it along with all the colours in the photo. 

1. Click on the Enhance menu and select Adjust Color, followed by Adjust Color 

for Skin Tone. 

The Adjust Color for Skin Tone box 

will be displayed.  (If this obstructs 

your view of the image, click and 

drag on the title bar to a new 

position.) 

2. In the image, click an area of the 

person's skin and observe the 

result. 

3. To further adjust the skin tone, drag 

the sliders in the Skin or Ambient 

Light boxes, or click on Reset to 

return to the original image. 

Spot Healing Brush 

The Spot Healing Brush is a quick way to remove blemishes or marks on a photo. 

1. Select the Spot Healing Brush    from the toolbox. 

2. On the Options bar, select a brush size. 

Note:  choosing a brush size slightly larger than the area to be changed generally 

works best. 

3. Select one of the following: 

Proximity Match  

(this uses pixels from around the edge of the selection to find a suitable area 

to use as a patch), or 

Create Texture 

(uses all the pixels in the selection to create a texture with which to fill the 

area.) 

If the result is unsatisfactory, click on the Undo button and try the other 

option, or choose a different brush size. 
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Magic Extractor Tool 

This tool allows you to extract an object from a photo and use it elsewhere.  By 

using different coloured dots to mark the foreground and background areas, you 

can control which part of the photo is selected for extraction. 

1. If appropriate, use the 

rectangular or oval 

marquee tool to define 

the area which will appear 

in the Magic Extractor 

window. 

2. Click on the Image menu 

and choose Magic 

Extractor. 

 

3. In the Magic Extractor 

window, select the 

Foreground Brush tool  

  and then click to 

mark the area you want to 

retain – by default this will 

show as red spots. 

4. To define the area which 

will be excluded, click on 

the Background Brush 

tool    and mark the 

area – this will be marked 

in blue. 

Note:  If either the foreground or background contains varied colours or textures, 

"dragging" with the brush may produce better results. 

5. Click the Preview button to see the results.  If necessary use the following 

tools to fine tune the selected area: 

Point Eraser – to remove foreground or background 

dots. 

Add to Selection – click or drag over area you want 

to add. 

Remove from Selection – to subtract dots. 

Smoothing Brush – drag over area to be removed. 

Zoom – click in the image to magnify; hold down 

ALT and click to zoom out. 

Hand – use to navigate around the photo. 
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6. Alternatively, to remove all marks, click on the Reset button to start again. 

7. To accept all the changes, click on OK.   

 

 

Back in the editor window, the image is still selected but all the excluded 

areas have been removed.  You can now copy it for use elsewhere. 

Note:  After doing this click on the Undo button to ensure the original photo 

remains the same. 

The Defringe Command 

When you make a selection and paste it elsewhere, some of the pixels 

surrounding the selection border may be included in the selection.  This can 

create a halo or fringe effect around the pasted object. 

When the Defringe command is used, it replaces the colour of the halo (fringe) 

pixels with the colour of pixels nearby which contain pure colours. 

Note:  the Defringe command will only work if the object is on a "Layer".  To 

check this, click on the Layers tab in the Palette Bin.  If the object is on the 

Background, click on the Layer menu, select New, followed by Layer from 

Background. 

1. On the Enhance menu select Adjust Color followed by Defringe Layer. 

2. The Defringe dialog box will prompt you to enter the number of pixels to be 

replaced – generally 1 or 2 is adequate. 

3. Click on OK. 
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Adding Text 

Vertical or horizontal text can be added to a photo either as a single line or as 

paragraph text.  Single line text shrinks or grows as it is edited and doesn't wrap 

to the next line.  Paragraph text wraps within the boundaries when you create a 

text box. 

1. To add text, select the Horizontal or 

Vertical Type Tool. 

2. To create a single line of text, click in 

the image where the text is to be positioned; to create paragraph text, click 

and drag to create a box. 

3. Before typing the text, select the relevant font, size, colour etc from the 

Options bar.  (Note: selecting the "anti-aliased" button makes text smoother.) 

4. Type in the text and if this is acceptable, click on the 

Commit button on the options toolbar.  If the result was 

unsatisfactory, click on the Cancel button and try again. 

 

5. Observe the Layer palette on the right-hand side of 

the window.   

Text is automatically entered in a "type" layer which 

appears about the background layer containing the 

image.  This means it can be manipulated without 

affecting the underlying photo. 

If you need to change the text at any time, you need 

to ensure that the type layer is selected. 

6. To reposition the text use the Marquee tool    to first select it. 

7. Select the Move tool   , then click and drag inside the selection to move 

the text to the new position. 

8. Press ESC, then click outside the text to deselect it.  

Note:  To delete a layer containing the text, select it in the layer palette and then 

click the Delete Layer    icon on the Palette Options bar. 
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Displaying the Image Size 

In the Full Edit Workspace, hold down the 

mouse on the information box beneath the 

image.  This will display the width and height 

(both in pixels and unit of measurement) and 

the resolution. 

Viewing the Print Size 

To get an idea of the print size, select the Hand or Zoom tool, and then click the 

Print Size button in the Options bar.  The image will then be displayed at the size 

it will be printed.   

Note:  Your monitor's size and resolution can affect the on-screen print size. 

PRINTING 

You can print photos one at a time from either the Quick Fix or Full Edit 

Workspace.   

1. With the relevant 

photo open, click on 

the Print button in 

the shortcuts bar, to 

display the Print 

Preview dialog box. 

2. Click on the Page 

Setup button and 

ensure the correct 

paper size and 

orientation are 

selected. 

 

 

3. In the Page Setup dialog box, click on the Printer button.  Select the correct 

printer, then in the same window click on the Properties button to set up the 

colour option (if desired). 

4. Click OK repeatedly to return to the Print Preview box. 

5. Observe the Print Size box which specifies the size of the printed image.  To 

choose an alternative size, click the arrow and choose from the list of Preset 

sizes.  Alternatively select Custom size, and then enter new sizes in the 

Scaled Print Size area. 

By default, the image will be centred on the page.  To change this, clear the 

Center Image box, and then type in new values in the Top and Left boxes. 

6. Click on Print. 
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SAVING IMAGES FOR THE WEB OR EMAIL 

When you want to publish images on the web, or transmit them via email, you 

should ensure they are optimised.  Optimising is the process of compressing an 

image and setting specific display options to keep the file size as small as 

possible (and therefore reducing download time) while preserving the colours and 

image details. 

 

1. With the image open, click on File, Save for Web. 

2. If necessary adjust the Zoom. 

3. Note the current file size, and estimated download time in the optimized 

image window.  As you make changes, this information will alter. 

4. Click on the arrow next to the Preset: box and observe the available formats: 

JPEG Ideal for displaying photos on the Web; it supports 24-bit colour so 

can display up to 16 million colours.  Uses a "lossy" compression 

technique that degrades the image.  

PNG-24 Good for photos but can create large files.  Only use instead of 

JPEG if the image contains transparency.  Supports 24-bit colour 
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so can display up to 16 million colours.  Uses lossless 

compression (ie does not degrade the image on saving, or 

restoring). 

GIF Best for low colour images such as logos, cartoons, drawings and 

text as it renders the image in 256 colours.  Supports background 

transparency.  Uses lossless compression. 

PNG-8 Alternative to GIF but not as widely known; displays up to 256 

colours.  Uses lossless compression. 

5. For Web photos select one of the JPEG options.  (The higher the quality the 

more detail will be preserved, however the file size will increase significantly.) 

6. Select the Progressive option.  This will display the image first at a low 

resolution which becomes sharper as the image downloads. 

7. In the Image Size section, note the 

Original Size Width: and Height: 

settings.   

8. Consider the monitor on which your 

picture(s) will be viewed; the screen 

resolution of many monitors is 1024 x 

768 pixels or less.  

Some browsers can automatically 

resize an image to fit the window; 

however, for those that don't, anyone 

viewing an image with a resolution 

larger than the monitor will need to 

scroll to see the whole image. 

9. To overcome this, select the Constrain Proportions box (to keep width and 

height proportional), and then under New Size enter a value in the Width: 

box.  (The Height: will adjust accordingly.) 

10. Click on Apply. 

11. To preview the optimised image in your web browser, click on the Preview In: 

button. 

12. If satisfactory close your browser and save the file with a new name.  If the 

result was unacceptable, try a different JPEG setting.   
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Viewing the Estimated Download Time 

1. To check the estimated download time for different speed modems click on 

the Preview Menu arrow  to the left of the Help button. 

2. Choose the appropriate download speed from the 

resulting shortcut menu.   

The download time beneath the image will adjust 

accordingly.   

3. If it seems too long, try different optimising 

settings or change the image size as described in 

the previous section. 

 

FURTHER INFORMATION 

1. For further assistance on any feature in Adobe PhotoShop, click on the Help 

button and select Photoshop Elements Help. 

2. In the Adobe Help 

Centre window, use 

the Search For: box 

to type in the item 

on which you need 

help. 

3. Ensure this 

product is selected 

and then click on 

Search. 

4. Browse through the 

Search Results in 

the left-hand pane, 

and then click the 

relevant article. 

Note:  to keep the Help window visible at all times, click on the Compact View 

icon    in the top-right hand corner. 
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